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Human Body and Health

Human Body

= From an engineering
perspective, the human body
can be defined as a

Brain
Hypothalamus

Pharynx

Larynx
Lymph nodes

combination of multi- igpont
. T ungs
disciplinary subsystems Arteries
(electro-mechanical- A4S Heart
chemical...). g A T Pone manow
"“1‘— :r—Gallbladder
Health Stomach
= Human health is a state of /}/ R WAL
complete physical, mental/ / Festies
/ , l Urinary bladder

and social well-being.
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Traditional Healthcare

Primary
Care

Specialists

Laboratories

» Physical presence needed
Hospitals > Deals with many stakeholders

» Stakeholders may not interact

» May not be personalized

» Not much active feedback

» No follow-up from physicians
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Electronic Health (eHealth)

= eHealth: The wuse of Information and
communication technologies (ICT) to improve
healthcare services.
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Source: W. O. Nijeweme-d'Hollosy, L. van Velsen, M. Huygens and H. Hermens, "Requirements for and Barriers towards
Interoperable eHealth Technology in Primary Care," IEEE Internet Computing, vol. 19, no. 4, pp. 10-19, July-Aug. 2015.
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Telemedicine

Telemedicine is the use of telecommunication and information
technology to provide clinical health care from a distance.
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Mobile Health (mHealth)

mHealth: Healthcare supported
by mobile devices that uses
mobile telecommunications and
multimedia technologies for the
delivery of healthcare services
and health information.

Source: H. Zhu, C. K. Wu, C. H. KOO, Y. T. Tsang, Y.Liu, H. R. Chi, and K. F. Tsang, "Smart Healthcare in the Era of
Internet-of-Things", IEEE Consumer Electronics Magazine, vol. 8, no. 5, pp. 26-30, Sep 2019.
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Connected Health (cHealth)

Patients / R
Hosplta Clinics <ho Dok Ja 2::::«
/ bo Tl - ‘/m WIMAX/3G
Barrio - N & cable | DSL/ Dialf ﬁ
”._._----g, —~ » " Universities

Long Term : ' T 7

- Conpacizs i
; rlzzlin X
Diagnostic Suppliers

Centers ; L Borsl

Laboratories

IVSS State Agencies

Source: https://www.slideshare.net/tibisay hernandez/connected-health-venfinal
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Smart Healthcare (sHealth)

Smart Hospital

Emergency Response Smart Home Fithess!
Trackers

Nurse Smart Infrastructure
T
Hotel
AT
T

e T [l
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,,,,,, Smart Gadgets ‘E

Headband with Embedded
Neurosensors

Embedded
8. Skin Patches

Q u al Ity an d Technician Robots
sustainable healthcare

with limited resources. U V)
Source: P. Sundaravadivel, E. Kougiaynos, S. P. Mohanty, and M. Ganapathiraju, “Everything You Wanted to Know
about Smart Health Care”, IEEE Consumer Electronics Magazine (MCE), Vol. 7, Issue 1, January 2018, pp. 18-28.
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Wearable Medical Devices (WMDs)

— — T

} N 2B - Headband with
.< \ = , Embedded
Neurosensors

Fithess
Trackers

Insulin Pump

o | | ‘ Embedded

Source: https://www.epatica.com/embraceZ/ § A N\l Sk
 \ IN

Medical grade smart
watch to detect seizure Patches
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Implantable Medical Devices (IMDs)

electrode

Pill Camera

acgmaker

RF Transmitter || Electromagnet

Source: P. Sundaravadivel, E. Kougianos, S. P. Mohanty, and M. Ganapathiraju,
“Everything You Wanted to Know about Smart Health Care”, IEEE Consumer
Electronics Magazine (MCE), Volume 7, Issue 1, January 2018, pp. 18-28.

pacemaker

Chollzabuety: Implantable MEMS —
Implantable and Wearable

Medical Devices (IWMDs)
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What i1s Smart Healthcare?

Smart Healthcare <
Conventional Healthcare
+ Body sensors
+ Smart Technologies

+Information & Communication Technology (ICT)
+ Al/ML

Healthcare Cyber-Physical Systems (CPS)

Source: P. Sundaravadivel, E. Kougianos, S. P. Mohanty, and M. Ganapathiraju, “Everything You Wanted to Know about
Smart Health Care”, IEEE Consumer Electronics Magazine (MCE), Volume 7, Issue 1, January 2018, pp. 18-28.
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Smart Healthcare - 4-Layer Architecture
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Source: M. Ghamari, B. Janko, R.S. Sherratt, W. Harwin, R. Piechockic, and C. Soltanpur, "A Survey on Wireless Body
Area Networks for eHealthcare Systems in Residential Environments", Sensors, 2016. 16(6): p. 831.
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Smart Healthcare -
Characteristics




Smart Healthcare
o
oooo

=
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DN et 9 = Gonsumer
Healthy Home Care @ @ Dj@[[ D@u§m
Living » Mobile health (%]
» Fitness « Telemedicine

Tracking . Self- @ 2
» Disease management ©

Prevention . Assisted o\
- Food Living 5

monitoring {7

Internet of Medical Things (IoMT) o

Frost and Sullivan predict smart health-care HHengt:fv?re

market value to reach US$348.5 billion by 2025. vour uaityof e NN

<9IEEE
Source: P. Sundaravadivel, E. Kougianos, S. P. Mohanty, and M. Ganapathiraju, _ Q

“Everything You Wanted to Know about Smart Health Care”, IEEE Consumer
Electronics Magazine (MCE), Vol. 7, Issue 1, January 2018, pp. 18-28.
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lIOMT - Impacts

Patient-specific care
with context and Improved inter-
enabled through

hoalth d device connection
g,t_e_art recoras. and synchronization

Real-time
tracking and
intervention

@gﬂ

A Development of evidence- Data driven

based guidelines which can health pred|ct|on
helpful to incorporate the local
intelligence in future machine.

Healthcare Cyber-Physical Systems (CPS)

Source: Y. Shelke and A. Sharma, "Internet of Medical Things", 2016, Aranca, https://www.aranca.com/knowledge-
library/special-reports/ip-research/the-internet-of-medical-things-iomt, Last Visited 10/18/2017.

Smart Healthcare -- Prof./Dr. Saraju P. Mohanty

11/06/2019 28



Smart Healthcare — 7Ps

Source: H. Zhu, C. K. Wu, C. H. KOO, Y. T. Tsang, Y.Liu, H. R. Chi, and K. F. Tsang, "Smart Healthcare in the Era of
Internet-of-Things", IEEE Consumer Electronics Magazine, vol. 8, no. 5, pp. 26-30, Sep 2019.
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Smart Healthcare - Tasks
4 Smart Healthcare - Tasks N

Daily Healthcare Clinical Boundary
(i1) Daily Diagnosis

(iii) Clinical Diagnosis

*Wearable Medical Sensor o _ _
(WMS)-based diagnosis t *Physician variance reduction

*Personalized diagnosis

(i) Daily Prevention

* Fitness checkup
* Activity tracking
* Emotion analysis

* Disease risk prediction 1
(v) Daily Treatment (iv) Clinical Treatment

* Treatment plan selection

* Treatment method evaluation
* In-patient monitoring

* Precision medicine j

 Out-patient therapy
* Ambient healthcare
* Disease status monitoring
K- Precision medicine

Source: Hongxu Yin, Ayten Ozge Akmandor, Arsalan Mosenia and Niraj K. Jha (2018), "Smart Healthcare", Foundations
and Trends® in Electronic Design Automation: Vol. 12: No. 4, pp 401-466. http://dx.doi.org/10.1561/1000000054
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loMT Advantages & Limitations

Advantages

Patients/Users

» Real-time interventions in emergency

» Cost reduction

» Reduced morbidity and financial
burden due to less follow up visits

Healthcare Service Providers

» Optimal utilization of resources

» Reduced response time in
emergency

Manufacturers

» Standardization/compatibility and
uniformity of data available

» Capalbility to sense and
communicate health related
information to remote location

Technical Challenges

“ Security of loT data - hacking and
unauthorized use of 10T

% Lack of standards and

communication protocols

Errors in patient data handling

Data integration

Need for medical expertise

Managing device diversity and

iInteroperability

*» Scale, data volume and performance

L)

XS

%

XS

%

XS

%

XS

%

Market Challenges

* Physician compliance

» Data overload on healthcare facility
» Mobile hesitation

¢ Security policy compliance

D)

L)

* 0.0

L)

(R )

Source: Y. Shelke and A. Sharma, "Internet of Medical Things", 2016, Aranca, https://www.aranca.com/knowledge-
library/special-reports/ip-research/the-internet-of-medical-things-iomt, Last Visited 10/18/2017.
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Smart Healthcare -
Components




Internet of Medical Things (IloMT)

Health Cloud

RFID Reader

‘ Online Data

\,‘ /),. """"" ﬁ»l | Patlent
Network Hub
~ Biobanks ;’ RequireS'

Wearables Clinical Trials Desktop Manager % Data and Device Security

% Data Privacy

lIoMT iIs a collection of medical sensors, devices, healthcare
database, and applications that connected through Internet.

Source: http://www.icemiller.com/ice-on-fire-insights/publications/the-internet-of-health-things-privacy-and-security/
Source: http://internetofthingsagenda.techtarget.com/definition/loMT-Internet-of-Medical-Things
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Smart Healthcare Sensors

Electroencephalogram (EEG) @

Electrocardiogram (E®G)

Smart Pill L]

Oximeter @
Electrodermograph 8
Electromyograph 8
Photoplethysmographz/ (PPGV &
Glucose monitorin

Thermal sensor

Pulse sensor ¥ .

Types of Sensors
@ Brain related applications

| Imaging applications
v Heartrelated applications
@ Skin related applications

6 Blood related applications

Smart Healthcare -- Prof./Dr. Saraju P. Mohanty
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Accelerometer . [ ] Ingestible sensors
Gyroscope . .
Magnetometer v of Z Motion Detection
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Smart Healthcare Communication

Bluetooth 4.0 (LE) 2.4 GHz 50-200 ~10 mW
Kbps

Zigbee 868 MHz/ 915 MHz/ 20-250 30 m 30 mW
2.4 GHz Kbps

ANT 2400-2485 MHz 1 Mbps Up to 0.01-1 mW

10 m

IEEE 802.15.6 2,360-2,400/ 2,400- NB:57.5- 1.2m 0.1 yW

2,483.5 MHz 485.7 Kbps

UWB: 3-10 GHz UWB: 0.5—-
HBC: 16/27 MHz 10 Mbps

Medical Implant 402-405 MHz Up to 500 2m 25 uW
Communications Kbps
Service (MICS)

Source: V. Custodio, F.J. Herrera, G. Lopez, and J. I. Moreno, “A Review on Architectures and Communications
Technologies for Wearable Health-Monitoring Systems”, Sensors, 2012. 12(10): p. 13907-13946.
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Smart Healthcare - Framework

/Smart Healthcare - System and Data Analytics : To Perform Tasks\

Systems & Analytics
*Health cloud server
*Edge server
*Implantable Wearable

Medical Devices (IWMDs) ', Ejoctronic Health Records (EHRS)
iaehineEeanIIEneie Machine Learning Engine

t t

Systems & Analytics

 Clinical Decision Support Systems
(CDSSs)

Data Data
*Physiological data *Physician observations
«Environmental data eLaboratory test results
*Genetic data *Genetic data
*Historical records *Historical records
Demographics Demographics

/

Source: Hongxu Yin, Ayten Ozge Akmandor, Arsalan Mosenia and Niraj K. Jha (2018), "Smart Healthcare", Foundations
and Trends® in Electronic Design Automation, Vol. 12: No. 4, pp 401-466. http://dx.doi.org/10.1561/1000000054
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Electronics Health Record (EHR)

Electronic Health -~ =

Father: Financial adwisor

Record (EHR) is the ——

systematized , | —
collection of health _ -
information of el FETY e

individuals stored in a
digital format.

Created by various
health providers such f:: et

. S Chethap |
as hospitals and e

Assist: 1 D0

clinics e ——
. Father ask many questions, add 10 minutes to
consultation
” nt doctol
ch |
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Machine Learning (ML)

Data Instance: features + label
Data Instance sets: training, testing
nference: Mathematical Model

Ensemble method: base vs. meta
Feature filtering: redundant vs. informative

Source: Hongxu Yin, Ayten Ozge Akmandor, Arsalan Mosenia and Niraj K. Jha (2018), "Smart Healthcare", Foundations
and Trends® in Electronic Design Automation, Vol. 12: No. 4, pp 401-466. http://dx.doi.org/10.1561/1000000054.
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Brain Computer Interface (BCI)

Sources: http://brainpedia.org/elon-musk-wants-merge-human-brain-ai-launches-neuralink/
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Virtual Reality in Healthcare

Source: https://touchstoneresearch.com/tag/applied-vr/
Source: http://medicalfuturist.com/5-ways-medical-vr-is-changing-healthcare/

In Surgery For Therapy
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Crowdsourcing for Smart Cities

Smart Healthcare Data
Gathering (Diet
Dataset, Healthcare

Dataset)
Urban Data
. Crowdsourcing Gathering (Bike
for Smart Cities Data, Energy

Usage Data)

o
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Smart Healthcare —
Challenges and Solutions




Smart Healthcare Architecture —
Requirements

Low power

Higher efficiency
Small form factor
; Inter operability
XContinuous connectivity
High speed

Security

Privacy

Smart Healthcare -- Prof./Dr. Saraju P. Mohanty
11/06/2019
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Smart Healthcare — Data Quality

Source: H. Zhu, C. K. Wu, C. H. KOO, Y. T. Tsang, Y.Liu, H. R. Chi, and K. F. Tsang, "Smart Healthcare in the Era of
Internet-of-Things", IEEE Consumer Electronics Magazine, vol. 8, no. 5, pp. 26-30, Sep 2019.
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Smart Healthcare - Security Challenges

—-Data Eavesdropping

—Data Confidentiality

—Data Privacy

Selected Smart || ) ;
Healthcare 1 Location Privacy

Security/Privacy :
Challenges —ldentity Threats

—Access Control

—Unique ldentification

—Data Integrity

Source: P. Sundaravadivel, E. Kougianos, S. P. Mohanty, and M. Ganapathiraju, “Everything You Wanted to Know about
Smart Health Care”, IEEE Consumer Electronics Magazine (CEM), Volume 7, Issue 1, January 2018, pp. 18-28.

& 0o 8
Sm Electronic Systems
Smart Healthcare -- Prof./Dr. Saraju P. Mohanty tory (S
11/06/2019 p UNT Sz

74



Health Insurance Portability and
Accountability Act (HIPPA)

. Data
Data I?lsclosed Compromised Improper
Wlthout_ by Hackers Disposal Of
Authorization 6% Data
from Patient 5%
‘. ’ 20% :
Data Lost and
H I PAA " NotAccounted
Other & For
Health Insurance Portability 2% £ ) : 12%
and Accountability Act p—t
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loOMT Security Issue Is Real & Scary

= Insulin pumps are vulnerable to hacking, FDA warns
amid recall:

https://www.washingtonpost.com/health/2019/06/28/insulin-pumps-are-

vulnerable-hacking-fda-warns-amid-recall/

= Software vulnerabilities in some medical devices could
leave them susceptible to hackers, FDA warns:

https://www.cnn.com/2019/10/02/health/fda-medical-devices-hackers-

trnd/index.html

= FDA Issues Recall For Medtronic mHealth Devices Over
Hacking Concerns:

https://mhealthintelligence.com/news/fda-issues-recall-for-medtronic-
mhealth-devices-over-hacking-concerns

Smart Healthcare -- Prof./Dr. Saraju P. Mohanty
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https://www.cnn.com/2019/10/02/health/fda-medical-devices-hackers-trnd/index.html
https://mhealthintelligence.com/news/fda-issues-recall-for-medtronic-mhealth-devices-over-hacking-concerns

loMT Security — Selected Attacks

Impersonation Eavesdropping

Attacks Attacks Physical
1 Attack

Smart
Healthcare

_ Network
Security Attack

Threats

Source: V. P. Yanambaka, S. P. Mohanty, E. Kougianos, and D. Puthal, “PMsec: Physical Unclonable Function-Based Robust and Lightweight
Authentication in the Internet of Medical Things”, IEEE Transactions on Consumer Electronics (TCE), Volume 65, Issue 3, August 2019, pp. 388--397.
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loMT Security Measures Is Hard -

Neurostimulator
4 Battery Life
| - 8 years

Pacemaker
| Battery Life
- 10 years

» Implantable Medical Devices (IMDs) have integrated battery to
provide energy to all their functions - Limited Battery Life
depending on functions

» Higher battery/energy usage - Lower IMD lifetime

» Battery/IMD replacement - Needs surgical risky procedures

Source: Carmen Camara, PedroPeris-Lopeza, and Juan E.Tapiadora, “Security and privacy issues in implantable medical
devices: A comprehensive survey", Elsevier Journal of Biomedical Informatics, Volume 55, June 2015, Pages 272-289.
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Our Secure by Design Approach for
Robust Security in Healthcare CPS

Communication
between Edge Server
and [oMT Devic

’ / )

/
/i

{ /]

&

— — Physical Unclonable Function
Mtk I;IEL-_'-'IE (PUF) based Solution

[oMT devices on the patient

Vulnerable to Attacks Attack 1 licious code by Attacker
Impersonating Server Communication
Threat Model between Edge Server
and [oMT Device

[oMT devices on

the patient No Malicious

Source: V. P. Yanambaka, S. P. Mohanty, E. Kougianos, and D. Puthal, “PMsec: Physical Unclonable Function-Based Robust Malicious code by Attacker
and Lightweight Authentication in the Internet of Medical Things”, IEEE Transactions on Consumer Electronics (TCE), Volume I ine S
65, Issue 3, August 2019, pp. 388--397. mpersonating Server
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Our Secure by Design Approach for

Robust Security in Healthcare CPS

End Devices Edge Router

-

i

— » Local Internet

_-‘-'

Area 3%
\ 7 - Network <:> ’
’ v
» Edge Servers , 7 (LA

’/

% " Remote
2. | Connection

I
i

N -

P ’

S
s N -~ ’

Doctor/ Nurse Remotely

Doctor / Nurse Locally

Gateway /

Source: V. P. Yanambaka, S. P. Mohanty, E. Kougianos, and D. Puthal, “PMsec: Physical Unclonable Function-Based
Robust and Lightweight Authentication in the Internet of Medical Things”, IEEE Transactions on Consumer Electronics
(TCE), Volume 65, Issue 3, August 2019, pp. 388--397.
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loMT Security — Our Proposed PMsec

Challenge 1

—_—

Lt
Challenge 2

Enrollment Phase

PUF Security Full Proof:

» Only server PUF Challenges
are stored, not Responses

» Impossible to  generate
Responses without PUF

Source: V. P. Yanambaka, S. P. Mohanty, E. Kougianos, and D. Puthal,
“PMsec: Physical Unclonable Function-Based Robust and Lightweight
Authentication in the Internet of Medical Things”, IEEE Transactions on
Consumer Electronics (TCE), Volume 65, Issue 3, August 2019, pp. 388--397.

PUF in the
Server

Response 1 Challenge
Response 2 Device Response
Output . . .
Hash = Device Registration Procedure
N’

Secure Database

Secure
Database

R1 —-C

R—C2

X = H(R2)

11/06/2019
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loMT Security — Our Proposed PMsec

Challenge 1 Response 1 Challenge
— >
PUF in the Device in
. ;
Challenge 2 Server Response 2 Question
Qutput
Hash
Compare
| Original
M String
\-_—/

Secure Database

Authentication Phase

Source: V. P. Yanambaka, S. P. Mohanty, E. Kougianos, and D.

Puthal, “PMsec: Physical Unclonable Function-Based Robust and -

Lightweight Authentication in the Internet of Medical Things”,

IEEE Transactions on Consumer Electronics (TCE), Vol. 65, No

3, Aug 2019, pp. 388--397.

Response

Device is
Authentic

Device is not
Authentic

[

Secure
Database

J

Compare
X |= X'

Device Authentication Procedure

Cl

R1"— ('

wco (R

-ne) ([
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loMT Security — Our PMsec in Action

Generating the Keys
Sending the keys to the Client
Receiving the Keys from the client
Saving the database
>>>

COM4
[
Hello
Received Key from the Server
Generating PUF Key

PUF Key : 1011100001011100101111000101111000101101001101110010100101000011
Sending key for authentication

Hello Output from Server during Authentication

Ser

Input to the PUF at server : 01001101

Generating the PUF key

Sending the PUF key to the client

PUF Key from client is 1011100001011100101111000101111000101101001101110010100101000011
SHA256 of PUF Key is : 580cdc9339¢c940cdc60889c4d8a3bcla3cl876750e88701cbd4£5223£6d23e76
Authentication Successful

>>> |

Source: V. P. Yanambaka, S. P. Mohanty, E. Kougianos, and D. Puthal, “PMsec: Physical Unclonable Function-Based Robust and Lightweight
Authentication in the Internet of Medical Things”, IEEE Transactions on Consumer Electronics (TCE), Volume 65, Issue 3, August 2019, pp. 388--397.
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IoI\/ITSecurlty )Our Proposed PMsec

Average Power
Overhead —
~ 200 pW

& PUF Module &
on FPGA B

Time to Generate the Key at Server 800 ms
Time to Generate the Key at IoMT Device 800 ms
Time to Authenticate the Device 1.2 sec - 1.5 sec

Source: V. P. Yanambaka, S. P. Mohanty, E. Kougianos, and D. Puthal, “PMsec: Physical Unclonable Function-Based
Robust and Lightweight Authentication in the Internet of Medical Things”, IEEE Transactions on Consumer Electronics
(TCE), Volume 65, Issue 3, August 2019, pp. 388--397.
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Blockchain for Smart Healthcare?

High Energy

Consumption 7 c IISIIIIIGI‘
EIGGIHONIES

[ 4

MAGAZINE

Lack of
Scalability

» Energy for mining of 1 bitcoin - 2 years £
consumption of a US household.

»Energy consumption for each bitcoin |
transaction -> 80,000X of energy
consumption of a credit card processing.

Source: D. Puthal, N. Malik, S. P. Mohanty, E. Kougianos, and G. Das, “Everything you Wanted to Know about the
Blockchain”, IEEE Consumer Electronics Magazine (CEM), Volume 7, Issue 4, July 2018, pp. 06--14.
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Blockchain Challenges - Energy

Transaction Validation
(The Network of Nodes
validates the transaction as
well as status of the user who
requested transaction using a
Validation Algorithm, e.g.
blic Key Cryptograp

The requested “Transaction” is
a broadcasted to a Peer-to-Peer (P2P)
| network consisting of Computing

Machines (i.e. “Nodes™). I
A “Transaction” is

requested by a Computing Peer-to-Peer (P2P) network of “Nodes”

combined with other verified A “Verified Transaction”

Machine (i.e. “Node™). The “Verified Transaction” is Q

transactions to create a new “Block”

of data for the Blockchain. Q_ 3

A “Block” Verified Transactions

(e.g. Cryptocurrency,
Contracts, Records).

lock Validation

(Using Consensus
Algorithm, e.g.
Proof-of-Work).

A “Validated Block” is added to the
existing Blockchain in a permanent and

unalterable way. “ ‘ O

Blockchain (i.e. Ledger) The Transaction is complete.

New Block Oldest Block

Source: D. Puthal, N. Malik, S. P. Mohanty, E. Kougianos, and G. Das, “Everything you Wanted to Know about the
Blockchain”, IEEE Consumer Electronics Magazine (CEM), Volume 7, Issue 4, July 2018, pp. 06--14.
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Our PoAh-Chain: The loT Friendly
Private Blockchain_for Authentication

Blockchain

IOT 2 s :
. T1 T2 T3
End Devices ---

Source: D. Puthal and S. P. Mohanty, "Proof of Authentication: loT-Friendly Blockchains", IEEE Potentials Magazine,
Volume 38, Issue 1, January 2019, pp. 26--29.
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Blockchain Consensus Types

Validation Based Voting Based  Authentication Based

X EL
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Our Proof-of-Authentication (PoAh)
Y el — 7))

A Create Block Solve Puzzle Broadcast the Proof-of-Work (PoW)
Proof-of-Work

Process (PoW)
: Eliminates cryptographic
Starts Agaln WW “puzz'e” So'ving to

validate blocks.

’____‘

Proof of Authentication (PoAh) Transmitto fTrusted Nodes\
Trusted Nodes: Network |

Nodes form Block
of Transactions

Uses a cryptographic
authentication mechanism.
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Our PoAh-Chain: Proposed New
Block Structure

- Hash of the - Hash of the

following: following:
--< « Hash of B, « Hash of B,
* Nonce of B ; . PoA_h of B,
Number only « Transactions Unique Block * Device I[_)
used once of B, Token (UBT) + Transactions
(Nonce) of B, ;

PoAh Block Structure

Conventional Block Structure

— J‘ IJ -

Sm Electro:
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Our PoAh i1s 200X Faster than PoW

Eliminates cryptographic
‘puzzle” solving to
validate blocks.

i® Block (i+1)® Block
ngh ngh ngh

[Catency T High High High o
Searchspace ~ High

Source: D. Puthal, S. P. Mohanty, P. Nanda, E. Kougianos, and G. Das, "Proof-of-Authentication for Scalable Blockchain in
Resource-Constrained Distributed Systems", in Proc. 37th IEEE International Conference on Consumer Electronics (ICCE), 2019.
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Machine Learning Challenges

Machine  _
Learning Issues

Source: Mohanty ISCT Keynote 2019
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Deep Neural Network (DNN) -
Resource and Energy Costs

TRAIN: Iterate until you achieve satisfactory performance. Needs Significant:
» Resource

( )

ACCESS AND EXTRACT OPTIMIZE
PREPROCESS DATA FEATURES TRAIN MODEL PARAMETERS > Energy

) A—

=

PREDICT: Integrate trained models into applications.

( h 4 N s ~
CAPTURE EXTRACT
SENSOR DATA i RUN MODEL PREDICTION
= =
¢ * —_
& 8§ - --:- -, -y ([l
D .

2 %" I b

v

Source: https://www.mathworks.com/campaigns/offers/mastering-machine-learning-with-matlab.html
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e Car

| | Labels
@ input Layer () Hidden Layer @ Output Layer
» DNN considers many training parameters, such as the

size, the learning rate, and initial weights.

» High computational resource and time: For sweeping
through the parameter space for optimal parameters.

» DNN needs: Multicore processors and batch processing.

» DNN training happens mostly in cloud not at edge or fog.
Source: Mohanty i‘SES‘ 2018 Keynote
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CE/loT System Multi-Objective Tradeoffs

Recurring Operational Cost

Source: Mohanty ICCE 2019 Keynote
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Smart Healthcare — Edge Vs Cloud

Edge Data Center
2o P
Upload__
w— ~~, Local
Area
——==""Network
Upload = (LAN)
~Ed~ge Rouer *"Download Cloud
y
Security/Intelligence
_Sensors Gateway / y g
(Things) Cluster > Big Data
' Middleware  Edge / Fog Plane 9
End/Sensing Devices  (Communication) > Lots of
: : - - Computational
End Security/Intelligence ~ Edge Security/Intelligence RESOUICe
» Minimal Data »Less Data »Accurate Data
» Minimal Computational »Less Computational Resource  Analytics
Resource »Less Accurate Data Analytics  »Latency in Network
» Least Accurate Data Analytics »Rapid Response »Energy overhead in
» Very Rapid Response Communications

Source: Our IFIP IoT 2019 Talk (Good-Eye: A Combined Computer-Vision and Physiological-Sensor based Edge Device
for Full-Proof Prediction and Detection of Fall of Adults)
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Smart Healthcare —
Specific Examples




ood Intake Monitoring and Diet
Management is Important

(=

Electronic
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Smart Healthcare — Diet Monitoring

User takes a picture of the Nutrition
Facts using Smart Phone

Automated Food intake
Monitoring and Diet
Prediction System

=Smart plate
=Data acquisition using mobile
*ML based Future Meal Pr

b2 [ Smart-Log
=]

User scans the barcode of the product

iction Weight and Time information obtained
through Sensing Board

Feedback to the user

.

& USDA National Nutrient Database
Data logged into Cloud used for nutrient values of 8791 items.

8172 user instances were considered

©

Camera to acquire Nutrient values

This Work Mapping nutrition facts to a database 98.4

Source: P. Sundaravadlvel K. Kesavan L. Kesavan S. P. Mohanty, and E. Kouglanos “Smart-Log: A Deep Learnlng based
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Smart-Log Diet Monitoring and
Prediction: DNN Model

Layer 2 . Layer 4
Hidden Layer 1 Hidden Layer 3
Weight of the meal Intended Nutritional goal

Output Layer

Layer 3 the meal
Layer 1 Hidden Layer 2
Input Layer Time consumed
Type of Meal
l \ J
Bayesian Network for classifying Neural Network for computing Nutritional balance

food items
Source: P. Sundaravadivel, K. Kesavan, L. Kesavan, S. P. Mohanty, and E. Kougianos, “Smart-Log: A Deep-Learning based

on_vionitoring I _In tne 10 Al ON_LCOnsulirl C ol 01 O NO
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Smart Healthcare - vision-Based Approach

' Automatic Food
(Y Image Analysis

Ll 2T

loT Cloud

Captures
Food

Accuracy of detecting food - 97%

Source: Mohanty ICCE 2019: "Stress-Log: An loT-based Smart System to Monitor Stress-Eating",
in Proceedings of the 37th IEEE International Conference on Consumer Electronics (ICCE), 2019.
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The data collected is sent to the Firebase Database in which
the calorie count is generated by using a dataset with
calories and sugars count of individual items from data.gov.

Source: Mohanty ICCE 2019: "Stress-Log: An loT-based Smart System to Monitor Stress-Eating",
in Proceedings of the 37th IEEE International Conference on Consumer Electronics (ICCE), 2019.
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Stress-Log: GUI

Carrier & 2:25PM  Carrier % 225PM  Cartier % 2:25PM  Carrier ¥ 2:25PM |Carrier ¥ 2:25PM
Meal Entry Mood Entry July 28,2018 Logout
Username: }
neustress Name of Food: ~ Noof Mood Before Eating; Normal Eating
SErvings:
Happy
Password: Cereal 2 Normal
ook gkekokkok Sad
Boiled E 1 |
Neustress - Food Input Mood Input
Gender: Mood After Eating:
- - [E
Male Time Consumed: ED:' Normal
e S Onstmet: _ Sad Calories Current
8 00 ar Consumed Mood
] [
Login - Submit - Submut ~Calories Remedies
Left
& © 5 8
Smart Electronic Systems
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Stress Is a Major Health Issue

Eustress

Divorce

Punishment

", Bad Stress

Distress

O Stress is the relationship between a person and a situation, which adversely
Impacts the happiness and health of the sufferer or physiological reactions.

O Stress can be divided into two parts: stressor and reaction.

O Stressor is the activity or effect that triggers a change in the physiological
parameter values of the human body.

U Reaction is the deviation of these parameter values from their normal levels.
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Smart Healthcare - stress Monitoring & Control

— S e e e e e e e =L L L I
Advise Examples: Specific Music, Shower, :
Physical Exercise, Breathing Exercise, Long- I
— Meditation, Yoga, ... Term I
Body Short-Term Advise Advise :
Temperature [\ . [ - _ _ _ I Stress :
|
Physical Activity : Efg:rl?ﬁgp Management |
Monitorin ' Jnit I -
< Based Stres * I - nternet
Sensor I I W Cloud
_ Models_ , Stress Wi-Fi | !
Sweat Sensor Level Modul :
Food Intake Stress-Level = I
Monitoring Detection Unit ~ Automated Stress

Level Detection
and Management

Accelerometer  0-75 75-100 101-200 3

(steps/min) 4 2 \/\/\/\_\/\/
Humidity (RH%) 27-65 66-91 91-120 !

Temperature ¥ 98-100 90-97 80-90 T e 0

Source: L. Rachakonda, S. P. Mohanty, E. Kougianos, and P. Sundaravadivel, "Stress-Lysis: A DNN-Integrated Edge Device for
Stress Level Detection in the IloMT", IEEE Transactions on Consumer Electronics (TCE), Vol 65, No 4, Nov 2019, pp. 474--483.
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Stress-Lysis: From Physiological Signals

-------------------------------------- ‘
|
Temperature .
Sen:ls,oor Deep Learning :
Sens| | Based Stress :
: - or i
Physical Activity Detection nternet
Monitoring ! - r(l:lerng
Sensor Stress-Level I = o
— i | :
Humidity Sensor DeLerclzittlon I
(For Sweat @ N
: . Stress-Lysis Thing |
---A-na-.l-SIE ------- -\- ------- -)--------1----g-l
1=t Hidden Layer 39 Hidden Layer
(Reads Sensor Values) (Stress Range Classification)
BTN
L ORHOZBO
) 4 (2 X
Humidity Sensor/) \ / \ / \ ‘/'
AAA bt
2°4 Hidden Layer
Input Stress Detecte
(Smmr:unma) l (Boundary-conditioned sensor values) ] ( SSource: E} Rachakonda, S. P. Mohanty, E. Kougianos,
and P. Sundaravadivel, "Stress-Lysis: A DNN-
1 Integrated Edge Device for Stress Level Detection in the
_ ~ Stress-Lysis Iﬁddm?—-“ﬁ'ﬁ? ) ~_loMT", IEEE Transactions on Consumer Electronics
(Weighted mnput and net output with activation function) (TCE), Vol 65, No 4, Nov 2019, pp. 474--483.
P [ Y V\
;._O_J‘ s -

lec‘tronic

S 8
Systems
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Smart Healthcare -- Prof./Dr. Saraju P. Mohanty

11/06/2019 126



Stress-Lysis: Experiments

LI ThingSpeak™ chsrels-  Appse  Commumity  Support »

ThingSpeak
Cloud Server

iStress 0 x iStress 2ol x

. Temperature Sensor Inpul
waz L» Low <N
asdLv7) S0484S 40

Humdity Sensor Input

Serial Monitor Window

= output. 3 &
M v O 4 4 4 “an 43 8
. rpul Teme inre
) Aszecol Mereewdny o MOGDae O oups i R O =
202 x iStress 202 x
ADXL335 : _
Accelerometer -l . Accelerometer Sensor Ingut Siress Range
- — \ = 00 4
Sensor , 10—
: ' : i \/\/\
L3} &N 15 LR ‘ . L]
rvr R brput Tione Senaot ingatt Time
Si7021 Temperature R == '

Source: L. Rachakonda, S. P. Mohanty, E. Kougianos, and P. Sundaravadivel, "Stress-Lysis: A DNN-Integrated Edge Device for
Stress Level Detection in the loMT", IEEE Transactions on Consumer Electronics (TCE), Vol 65, No 4, Nov 2019, pp 474--483.
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Smart Healthcare — Smart-Pillow

Automatically monitors
stress levels during the day
and relates to sleeping
behaviors at night.

- o o -

| / Lss A/ K

Tracking : : :

. Unit ML :

[ : Parameter 7/ >S A : I

! > t V‘ Analysis Unit l :
arameter -

: Range I $ /[ MSS A ! :

| Comparison : Stress State : User |

| Unit y | Prediction Y MHSS A, Il

| Cl o unit | \2isplay /i

| | I '

\ ]

« Processing Unit , > HSS

—————————————

Source: Mohanty iSES 2018: “Smart-Pillow: An loT based Device for Stress Detection Considering
Sleeping Habits”, in Proc. of 4th IEEE International Symposium on Smart Electronic Systems (iISES) 2018.
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Smart Healthcare

Seizure Detection & Control

s EEG Signal -
o , g Seizure SeIZUI‘e State
Detection | |, | =
Drug Yes | Dosage Hostal
Injection Drug Information e &
o Dol el == === > o™
| elivery - 7o 28
Unit V_}_/welefss Cloud Storage Y
EEG Data - - lransier _ Doﬁqr
Acquisition Sensor Unit Transmission and Storage Access Unit
Seizure L Seizure
Onset i .+ Detection
- 100 - : | M“ ”m
E.mo : l l“«ﬂ' llm| |i t8ncy 6 sec i
200 | } {I ‘ Jétection - 1 to 2 sec
300 AL eizure Predication -
- | | . & at least 6 sec before
04 10 CD 30 »% Tlm.’;o(sec) 80 70 80 S0 100

Source: M. A. Sayeed, S. P. Mohanty, E. Kougianos, and H. Zaveri, “eSeiz: An Edge-Device for Accurate Seizure Detection
for Smart Healthcare”, IEEE Transactions on Consumer Electronics (TCE), Volume 65, Issue 3, August 2019, pp. 379--387.
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Seizure Detection Approaches

e

EEG Testing
Sienal DWT based Data-Set
Preprocessing =] Splitting

Wireless

Transfer @ Doc‘mr
Selzure’7

Unit Unit —r
*m I | Channel  Statistical
S I selection P
EEG Trammg 1 : arameter (YeS/N 0) Internet/ —
Data Sets Set : } oA | Deep Neural Cloud
I R Network (DNN) 1 Hospital
I Classifier
L--------------------------------------------I
< — , , , —>< T
EEG Data Acquisition, processing and Seizure Detection Data Transmission Data Access
‘ ' e o Aol and Data Storage
-Cus:c Z:IAD \5 E

Cloud Vs Edge Computing

=3
o0

Cloud-loT 2.5 sec 98.65%
based Detection

Edge-loT based | 1.4 sec | 98.65%
Detection

Accuracy (%)

=
~1

96

95

Kumar, et al. [2014] Tawfiq, etal. [2016] Yavuz, et al. |[2018]  Proposed system

Source: M. A. Sayeed, S. P. Mohanty, E. Kougianos, and H. Zaveri, “Neuro-Detect: A Machine Learning Based Fast and Accurate
Seizure Detection System in the IloMT”, IEEE Transactions on Consumer Electronics (TCE), Vol 65, No 3, Aug 2019, pp. 359--368.
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Seizure Control Methods

Inlet
From _ _ _ -> |_/'|

Reservorr Pump Chamber Electromagnetic: Latency —

1.8 Sec, Power —12.81 mW,

Magnet \ Flow Rate — 0.34 mL/min
. Source: M. A. Sayeed, S. P. Mohanty, E. Kougianos,
Dlaphragm and H. Zaveri, "An loT-based Drug Delivery System
Supply — TErE Eefr?cttory Epilelpsy"é in]c Proceedings ofC the 37th
. nternationa onrterence on onsumer
Voltage <————— Coil Electronics (ICCE), 2019.
. Piezoelectric Diaphragm _ _
Switch Disc Epileptegenic
S1 zZone
( \) Drug Drug I
Inlet Outlet !
— -
. Pump e
_ _ Chamber
Piezoelectfic: Latency — 1.8] Sec,
Reservoir 2 Reservoir 1 Power — 29 mW, L /min

Source: M. A. Sayeed, S. P. Mohanty, E. Kougianos, and H. Zaveri, “iDDS: An Edge-Device in loMT for Automatic Seizure Control
using On-Time Drug Delivery", in Proceedings of the 38th IEEE International Conference on Consumer Electronics (ICCE), 2020.

P [T
=04 &V =p
. Sm Electronic Systems
Smart Healthcare -- Prof./Dr. Saraju P. Mohanty atory (S

133

11/06/2019



Smart Healthcare — Brain as a
Spatial Map =2 Krlgmg Methods

*n/arcmap/10.3/tools/3d-

Cerebellum

analyst-toolbox/how-krigig

Spatial autocorrelation principle
- Seizure Signal | @KnownLabels - things that are closer are more
== uu1 Spatial Correlation @ Unknown Labels  glike than things farther

Source: I. L. Olokodana, S. P. Mohanty, and E. Kougianos, "Ordinary-Kriging Based Real-Time Seizure Detection in an Edge
Computing Paradigm", in Proceedings of the 38th IEEE International Conference on Consumer Electronics (ICCE) 2020, Accepted.
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Kriging based Seizure Detection

-

N\

N )

Signal Feature Seizure State
Denoising Extraction Classification

' : : Seizure

I I |

I > I > I »Status
. ) I (S S - SR |
Wavelet ! . Fractal : . Kriging |
-Transformatlons: ' Dimension | . Classifier !
............... '._._._._._._. '._._._._._._!

Zandi, et al. 2012
[23]

Altaf,etal. 2015 [24]

Vidyaratne, et al.
2017 [25]

Our Proposed

Regularity, energy &

combined seizure indices

Digital hysteresis

Fractal dimension, spatial/

temporal features

Petrosian fractal dimension

Cumulative Sum 91.00%

thresholding
Support Vector Machine 95.70%

Relevance Vector 96.00%
Machine (RVM)
Kriging Classifier 100.0%

9 sec.

1 sec

1.89
sec

0.85s

Source: I. L. Olokodana, S. P. Mohanty, and E. Kougianos, "Ordinary-Kriging Based Real-Time Seizure Detection in an Edge
Computing Paradigm", in Proceedings of the 38th IEEE International Conference on Consumer Electronics (ICCE) 2020, Accepted.
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Blood Glucose Monitoring —
Invasive Vs Noninvasive

Front view Back view

Sensor

(finger) (wrist)

Photoplethysmogram (PPG) Near Infrard (NIR)

PPG Signal Analysis NIR Spectroscopy

Specific

- B WSPTiﬁgih LED Detector
" avelengths are avelengths . -
Traditional — oo aceded for cueons 3 (==
Fi nger Pricki ng molecule detection l
e e s Logged vultag.e values
analysis and features gl H.bﬁﬁlptl.ﬂﬂ iad
m— reflectance of light from
B N glucose molecule

& 0 8
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Smart Healthcare — IGLU —

Noninvasive, Accurate, Continuous Glucose Monitoring

Vibrations @ @

(Stretching, SRy, (S
Wagging, Bendi
) agging, Bending) ) 1 Attenuated Infrared

- S
T
“ b BN
| —
= ~

S
N T
S\

= T Wave .- Detector

~
.................. >

Y (()BE

‘ Analog-to-Digital
Converter

-~
—

—-*
~_*

Near |nIrz_;1red Transmitted Wave
(NIR) Emitters

—

(940nm, F i
1300nm) F——1 4 (ADS1115)
Infrared Detecﬁ"

Cost - US$ 20
Accuracy - 100%

Source: P. Jain, A. M. Joshi, and S. P. Mohanty, “iGLU: An Intelligent Device for Accurate Non-Invasive Blood Glucose-Level
Monitoring in Smart Healthcare”, IEEE Consumer Electronics Magazine (MCE), Vol. 9, No. 1, January 2020, pp. To Appear.
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Internet of Every Things (loE)

People Process
Connecting people to the Internet  Deliver right information to right _
for more valuable communications  place, person or machine at the Requires:
E Implantable Medical Lo C i Data_"
Device (IMD) B Device,
% cal ] f and
Wearable Medical nternet o A System
Device (WMD - _
) Everything Security

Data (IoE) Things E % Data,

Collecting data and leverage it Devices comnected fo each Location,
for decision making R and
- == (Internet of Things (IoT)). System
Privacy

o Perform decision making
| Crowdsourcing whenever necessary. gi

Source: S. P. Mohanty, V. P. Yanambaka, E. Kougianos, and D. Puthal, "PUFchain: Hardware-Assisted Blockchain for Sustainable Simultaneous

Device and Data Security in the Internet of Everything (IoE)", arXiv Computer Science, arXiv:1909.06496, September 2019, 37-pages.
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Conclusions and
Future Research
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Conclusions

Healthcare has been evolving to Healthcare-
Cyber-Physical-System (CPS) I1.e. smart
healthcare.

Internet of Medical Things (IloMT) plays a key
role smart healthcare.

Smart healthcare can reduce cost of
healthcare and give more personalized
experience to the individual.

loMT provides advantages but also has
limitations in terms of security, privacy, etc.
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Future Research

Internet-of-Everything (loE) with Human as
active part as crowdsourcing need research.

loE will need robust data, device, and CPS
security need more research.

Security of IWMDs needs to have extremely
minimal energy overhead to be useful and
hence needs research.

Integration of blockchain for smart healthcare
need research due to energy and
computational overheads associated with It.
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